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TURVALLISUUTESI VUOKSI Lue nämä ohjeet. Ohjeiden vastainen käyttö 
saattaa olla vaarallista tai lainvastaista. Lisäohjeita löydät erillisestä 
Käyttöoppaasta.

LIIKENNETURVALLISUUS Älä käytä kommunikaattoria ajaessasi; pysäköi 
ensin autosi.

HÄIRIÖT Kaikki matkapuhelimet ovat alttiita häiriöille, jotka voivat 
vaikuttaa niiden toimintaan.

SULJE PUHELIN SAIRAALASSA Noudata ohjeita ja sääntöjä. Sulje 
puhelin lääketieteellisten laitteiden lähellä.

SULJE PUHELIN LENTOKONEESSA Matkapuhelimet voivat aiheuttaa 
häiriöitä. Niiden käyttö lentokoneessa on lainvastaista.

SULJE PUHELIN TANKATESSASI Älä käytä puhelinta huoltoasemalla. 
Älä käytä puhelinta polttoaineen tai kemikaalien läheisyydessä.

SULJE PUHELIN RÄJÄYTYSTYÖMAAN LÄHELLÄ Älä käytä puhelinta 
räjäytystyömaan lähellä. Huomioi rajoitukset ja noudata ohjeita ja 
määräyksiä.

KÄYTÄ JÄRKEVÄSTI Käytä puhelinta vain normaaliasennossa. Älä koske 
antenniin tarpeettomasti.

VALTUUTETTU HUOLTO Vain valtuutettu huoltoliike saa asentaa tai 
korjata puhelimen.

LISÄLAITTEET JA AKUT  Käytä vain hyväksyttyjä lisälaitteita ja akkuja. 
Älä liitä yhteensopimattomia tuotteita toisiinsa.
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SOITTAMINEN LAITTEEN PUHELIMELLA Sulje kansi ja varmista, että 
puhelimessa on virta ja että se on verkon kuuluvuusalueella. Näppäile 
puhelinnumero suuntanumeroineen ja paina -näppäintä. Lopeta 
puhelu painamalla -näppäintä. Vastaa puheluun painamalla -
näppäintä.

HÄTÄPUHELUT Sulje laitteen kansi. Varmista, että puhelimessa on virta 
ja että se on verkon kuuluvuusalueella. Tyhjennä näyttö pitämällä -
näppäintä alhaalla muutaman sekunnin ajan. Näppäile hätänumero ja 
paina -näppäintä. Ilmoita olinpaikkasi. Älä katkaise puhelua ennen 
kuin saat luvan siihen.

VARMUUSKOPIOIDEN TEKEMINEN Muista tehdä varmuuskopiot 
kaikista tärkeistä tiedoista.

LIITTÄMINEN MUIHIN LAITTEISIIN Toiseen laitteeseen liitettäessä lue 
tarkat turvaohjeet laitteen käyttöohjeista. Älä liitä yhteensopimattomia 
tuotteita toisiinsa.

INFRAPUNAVAROTOIMET Älä osoita infrapunasädettä kenenkään 
silmiin äläkä anna sen häiritä muita infrapunalaitteita.
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ohjelmat
Vihje: Lisätietoja 

ohjelmien asentamisesta on 
Käyttöoppaassa.

Tässä oppaassa on tietoja ohjelmista, joita voit asentaa myyntipakkauksesta 
löytyvältä CD-ROM-levyltä. Nämä sovellukset löytyvät osista Ohjelmia 
kommunikaattoria varten ja PC-ohjelmat. Huomaa, että joillakin lisäohjelmilla on 
omat käyttöoppaansa. Ne ovat CD-ROM-levyllä ohjelmien vieressä.

Ohjelmien asentaminen CD-ROM-levyltä
Kommunikaattorin CD-ROM-levyllä olevat sovellukset ja tiedostot ovat valmiita 
asennettaviksi tai siirrettäviksi kommunikaattoriin. Tee asennus seuraavasti:
1 Varmista, että olet asentanut PC Suite -ohjelman tietokoneeseen. Tämä 

ohjelma löytyy myyntipakkauksessa olevalta CD-ROM-levyltä.
2 Aseta CD-ROM-levy tietokoneen CD-ROM-asemaan.
3 Tee joko näin: Kytke kommunikaattori tietokoneeseen myyntipakkauksessa 

toimitetun sarjakaapelin avulla. 
Tai näin: Valmistele kommunikaattori ja tietokone infrapunayhteyttä varten. 
Lisätietoja on Käyttöoppaassa.

4 CD-ROM-levy avautuu automaattisesti. Jos näin ei tapahdu, avaa CD-ROM-
levyn käyttöliittymä napsauttamalla kahdesti tiedostoa Nokia9210.exe 
CD-ROM-levyn hakemistopuusta.
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napsauta Asenna.

Vihje: Käytä 
kommunikaattorissa 
muistikorttia, jolloin saat 
lisätilaa CD-ROM-levyllä 
olevia eri sovelluksia ja 
tiedostoja varten.

Huomaa: Muista asentaa kommunikaattorisi kielen kanssa samankieliset 
lisäsovellukset.

Etäsynkronointi
Nokia 9210 Communicatoria varten tarkoitetun Etäsynkronointi-sovelluksen 
avulla voit synkronoida kalenterin ja osoitetiedot GSM-datapuhelun kautta 
erilaisten Internet-kalenteri- ja osoitekirjasovellusten sekä useiden toimisto-
ohjelmistoratkaisujen (kuten Lotus Notesin) kanssa. Synkronointisovellus käyttää 
synkronointiin SyncML-tekniikkaa.

Etäpalvelinasetuksia kutsutaan synkronointiprofiileiksi. Voit määrittää useita 
profiileja, jos tietoja on synkronoitava useiden palvelinten tai sovellusten kanssa.

Huomaa: Jos tarvitset SyncML-yhteensopivuutta koskevia tietoja, ota yhteys 
palveluntarjoajaan tai yrityksen käyttötukeen.

Huomaa: Tässä tuotteessa on SyncML Initiativen kehittämiä ohjelmia.

Uuden synkronointiprofiilin luominen
Kun käynnistät Etäsynkronointi-sovelluksen, nykyinen synkronointiprofiili näkyy 
päätasolla otsikon Etäsynkronointi alla. Jos mitään profiilia ei ole luotu, näkyvissä 
on teksti (Profiileja ei määritetty). 

Voit luoda uuden profiilin seuraavasti:
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Kuva 1

Vihje: Kun lisäät 
vanhaan profiiliin 
perustuvaa profiilia, valitse 
sellainen profiili, jonka arvot 
ovat lähimpänä uuden 
profiilin arvoja.

1 Jos profiileja ei ole määritetty, paina Uusi. Valintaikkuna avautuu. Jatka 
vaiheesta 4.

2 Jos vähintään yksi profiili on jo määritetty, saat esiin käytettävissä olevat 
profiilit painamalla päätasolla Profiilin asetukset. 

3 Voit luoda uuden profiilin jonkin vanhan profiilin asetusten perusteella 
valitsemalla käytettävän profiilin perustaksi ja napsauttamalla Uusi. 
Valintaikkuna avautuu.

4 Tee seuraavat määritykset:

Yleiset-sivu
Vihje: Käytön 

helpottamiseksi aseta eniten 
käytetty profiili 
oletusprofiiliksi.

Oletusprofiili: Vähintään yksi käytettävissä olevista synkronointiprofiileista on 
määritettävä oletusprofiiliksi. Voit määrittää tämän profiilin oletukseksi 
valitsemalla Kyllä. Oletusprofiili näkyy päätasolla ja on siten nopeasti 
käytettävissä.

Profiilin nimi: Anna profiilille kuvaava nimi. Esimerkki: "Toimistokalenterini". 
Kullakin profiililla on oltava ainutkertainen nimi.

Valitse/Internet-yhteys/Palvelimen osoite/Portti/HTTP-tarkistus: Saat oikeat arvot 
palveluntarjoajalta tai järjestelmän pääkäyttäjältä.
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tunnuksen palveluntarjoajalta tai järjestelmän pääkäyttäjältä.

Salasana: Kirjoita salasanasi tähän. Turvallisuussyistä salasana näkyy 
tähtimerkkeinä (*****). Saat oikean salasanan palveluntarjoajalta tai 
järjestelmän pääkäyttäjältä.

Huomaa: Asetukset-painike on käytettävissä vain kentässä HTTP-tarkistus.

Tiedot-sivu

Kuva 2

Tältä sivulta voit valita palvelimen kanssa synkronoitavat tiedot. 
1 Valitse sovellus nuolinäppäimellä ja valitse sitten Kyllä tai Ei napsauttamalla 

Muuta.
2 Voit määrittää kalenterin tai osoitetietojen asetukset painamalla Asetukset. 

Valintaikkuna avautuu. Tee seuraavat määritykset:
Kalenteritiedosto/Osoitetiedosto: Valitse oikea tietokanta kommunikaattorista 
painamalla Selaa.
Etäkalenteri/Etäosoitekirja: Lisätietoja saat palveluntarjoajalta tai järjestelmän 
pääkäyttäjältä.
Huomaa: Kalenteritietoja voi synkronoida vain, kun kommunikaattorissa on 

kalenteritiedosto. Luo kalenteritiedosto Kalenteri-sovelluksen avulla.
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1 Tarkista päätasolla, että olet valinnut oikean profiilin. Paina Synkr. 
Synkronoinnin tila näkyy näytön alareunassa.

2 Voit keskeyttää synkronoinnin painamalla Peru. 
3 Saat ilmoituksen, kun synkronointi on päättynyt. Voit avata lokitiedoston 

painamalla Näytä loki tai palata päätasolle painamalla Sulje.

Palvelinprofiilien muokkaaminen
1 Paina päätasolla Profiilin asetukset. Esiin tulee palvelinprofiililista.
2 Valitse muokattava profiili nuolinäppäimellä ja paina Muokkaa.
3 Muokkaa profiilia tarpeen mukaan. Saat oikeat arvot palveluntarjoajalta, 

järjestelmän pääkäyttäjältä tai käyttöoppaasta. Yksityiskohtaisia asetustietoja 
on kohdassa Yleiset-sivu sivulla 3 ja kohdassa Tiedot-sivu sivulla 4.

4 Hyväksy muutokset ja sulje valintaikkuna napsauttamalla Sulje.

Palvelinprofiilien poistaminen
1 Paina päätasolla Profiilin asetukset. Esiin tulee palvelinprofiililista.
2 Valitse poistettava profiili nuolinäppäimellä ja paina Poista.

Synkronointi toisen palvelimen kanssa
1 Paina päätasolla Profiilin synkr. Esiin tulee palvelinprofiililista.
2 Valitse profiili ja paina Synkr.
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Voit katsoa profiilin viimeisintä synkronointilokia. 
1 Paina päätasolla Profiilin synkr. Esiin tulee palvelinprofiililista.
2 Valitse profiili ja paina Näytä loki. Lokissa näkyy päivitettyjen, lisättyjen tai 

poistettujen kohteiden määrä.

Yksikkömuunnin
Nokia 9210 Communicatoria varten tarkoitettua Yksikkömuunnin-sovellusta 
käytetään mittayksiköiden muuntamiseen.

Kuva 3

Avaa muuntotyökalu valitsemalla muuntoluokka päätasolta ja painamalla Avaa.

Muuntoluokat ja yksiköt ovat seuraavat:

Muuntoluokka Yksikkö A Yksikkö B

Valuutta USD EUR

Pinta-ala ft2 m2
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Kunkin muuntoluokan muuntotyökalussa on kaksi kehystä. Katso kuvaa 3.

Vihje: Kehyksestä toiseen 
voi siirtyä 
sarkainnäppäimellä.

Vain yksi kehys kerrallaan voi olla aktiivisena. Kehyksissä on aina toisiaan 
vastaavat arvot; jos jommankumman kehyksen arvoa muutetaan, toinen kehys 
päivittyy automaattisesti.

Huomaa: Laskimen tarkkuus on rajallinen, ja pyöristysvirheitä voi esiintyä.

Yksikön vaihtaminen
Muuntoluokassa käytettäviä yksiköitä voi tarvittaessa vaihtaa. Esimerkiksi 
valuuttaluokassa muunto voidaan tehdä valuutasta FRF valuutan USD sijasta.
1 Paina Vaihda yksikkö haluamasi muuntoluokan muuntotyökalussa. 

Valintaikkuna avautuu.
2 Valitse yksikkö listalta tai etsi yksikkö kirjoittamalla merkkejä hakukenttään.

Energia kcal kJ

Pituus mi km

Paino lb kg

Voima hv kW

Paine Pa bar

Lämpötila F C

Aika d h

Nopeus mph km/h

Tilavuus gal (US) litra
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Valuuttayksiköiden lisääminen ja muokkaaminen
Huomaa: Vain valuuttayksiköitä voi muokata, poistaa ja lisätä.

Vihje: Voit poistaa 
valuutan valitsemalla sen ja 
painamalla Menu-
näppäintä. Valitse sitten 
Tiedosto > Poista valuutta…. 
Paina Poista.

1 Valitse ja avaa valuuttaluokka.
2 Voit muokata valuuttaa valitsemalla sen ja painamalla Avaa.

Voit lisätä valuutan painamalla Menu-näppäintä ja valitsemalla Tiedosto > Uusi 
valuutta….
Valintaikkuna avautuu.

3 Tee seuraavat määritykset:
Nimi: Valuuttayksikön nimi.
Symboli: Valuuttayksikön lyhenne.

4 Määritä seuraava tieto painamalla Laske suhde:
Suhde: Perusyksikön perusteella määritetty muuntokurssi.
Valintaikkuna avautuu.

5 Määritä uuden ja perusvaluuttayksikön arvot ja paina OK.
6 Hyväksy muutokset painamalla Valmis.

Tiedostojen katselu
Tiedostojen katselu -sovelluksen avulla voidaan katsoa erilaisia tekstinmuokkaus-, 
grafiikka- ja muita tiedostomuotoja. Lisäksi voidaan avata ja purkaa arkistoituja 
tiedostoja.
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Kuva 4

Tuetut tiedostomuodot
CD-ROM-levyllä on viisi asennustiedostoa, jotka tukevat erilaisia tiedostomuotoja. 
Seuraavassa on lueteltu käytettävissä olevat asennustiedostot ja niitä vastaavat 
tuetut tiedostomuodot.

Asennustiedosto Tuetut tiedostomuodot Tuetut tiedostojen tarkentimet

Kaikki asennustiedostot

Pelkkä teksti TXT

Windows-bittikartta BMP, RLE, ICO, CUR

Portable Network Graphics PNG

Windows-metatiedosto WMF, EMF

MS_Powerpoint.sis Microsoft Powerpoint 3/4/7/97/
98/2000 PPT, POT, PPS

MS_Excel.sis Microsoft Excel 2/3/4/5/7/97/98/
2000 XLS, XLC
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MS_Office.sis

Microsoft Powerpoint 3/4/7/97/
98/2000 PPT, POT, PPS

Microsoft Excel 2/3/4/5/7/97/98/
2000 XLS, XLC

Microsoft Word 1/2/4/5/6/7/97/
98/2000 DOC, WRI

Lotus_WP_AMI.sis

Lotus 1-2-3 v. 1/2/3/4/5/97/
Millenium

WQ1, WKU, WK1, WK3, WK4, 
WK5, WK6, 123

Lotus Ami Pro SAM

WordPerfect 4/5/6/7/8 WPD

WordPerfect-grafiikka WPG

Lotus Ami Draw SDW

Other.sis: kuvamuodot

Computer Graphics -metatiedosto CGM

Compuserve GIF GIF

Paintbrush PCX, DCX

Tagged Image File Format TIF, JPG, JIF

Other.sis: tekstimuodot

Internet Hypertext Markup 
Language HTML

Pelkkä teksti TXT

vCard VCF

Rich text format RTF
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Tiedostojen katselu
Huomaa: Käytettävissä olevat valikkovaihtoehdot ja -komennot määräytyvät 

katseltavan tiedoston tyypin mukaan.

1 Valitse Tiedostojen katselu Ekstrat-sovellusryhmästä ja paina Enter-näppäintä.
2 Avaa-valintaikkuna tulee esiin.
3 Etsi tuettu tiedosto painamalla Selaa ja paina OK. Tiedosto avautuu. Tiedoston 

tyypin mukaan käytettävissä ovat seuraavat vaihtoehdot:

Kaikki tiedostot
• Voit muuttaa näkymää painamalla Suurenna ja Pienennä. 
• Paina Menu-näppäintä ja valitse Näytä > Koko näyttö -tila, jos haluat näytölle 

pelkästään dokumentin tai tiedoston sisällön.
• Voit lähettää tiedoston painamalla Lähetä. Lähetä-valintaikkuna avautuu. 

Vaihtoehdot ovat Sähköpostina / Infrapunan kautta. Vahvista lähetys painamalla 
Lähetä.

• Voit sulkea sovelluksen painamalla Sulje.

Other.sis: arkistoidut tiedostot

Winzip, PKZIP ZIP, EXE

Unix Gzip TGZ

Unix Compress TAR, TAZ

Other.sis: muut muodot
Microsoft Project MPP

Visio VSD
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• Paina Menu-näppäintä ja sovita tiedosto näytön leveyteen valitsemalla Kuva/

Dokumentti > Sovita leveyteen.
• Sovita tiedosto näytölle valitsemalla Kuva/Dokumentti > Sovita ikkunaan.

Tekstidokumentit ja laskentataulukot
Dokumentti- tai Taulukko-valikossa on useita katseluvaihtoehtoja:
• Luonnosnäkymä: Voit valita luonnosnäkymän painamalla Menu-näppäintä ja 

valitsemalla Dokumentti > Luonnosnäkymä tai Taulukko > Luonnosnäkymä. 
Luonnosnäkymässä dokumentti- tai laskentataulukkotiedoston teksti näkyy 
yhdellä fontilla. Lisäksi merkkien muotoilu, kappaleiden tasaus, rivivälit ja 
sarkaimet näkyvät. Upotetut tiedostot eivät näy luonnosnäkymässä. 

• Normaali näkymä: Voit valita normaalin näkymän painamalla Menu-näppäintä 
ja valitsemalla Dokumentti > Normaali näkymä tai Taulukko > Normaali näkymä. 
Normaalissa näkymässä myös kaikki fontit ja upotetut objektit näkyvät 
samanlaisina kuin alkuperäisessä dokumentissa.

Vihje: Tekstidokumenttia 
katsellessasi voit valita 
tekstiä, kopioida sen 
leikepöydälle ja liittää sen 
toisiin sovelluksiin.

• Sivunäkymä: Voit valita sivunäkymän painamalla Menu-näppäintä ja 
valitsemalla Dokumentti > Sivunäkymä tai Taulukko > Sivunäkymä. 
Sivunäkymässä dokumentti- tai laskentataulukkotiedoston teksti näkyy 
samanlaisena kuin alkuperäisessä dokumentissa. Myös kaikki automaattiset 
rivinvaihdot, sarakkeet, sivun reunukset, ylätekstit, alatekstit ja huomautukset 
näkyvät.

Kuvat
• Paina Menu-näppäintä ja sovita kuva näytön leveyteen valitsemalla Kuva > 

Sovita leveyteen.
• Sovita kuva näytölle valitsemalla Kuva > Sovita ikkunaan.
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• Voit katsoa kuvaa sellaisena kuin se oli avattaessa valitsemalla Kuva > Palauta 
alkuperäinen.

Arkistoidut tiedostot
• Voit purkaa valitut tiedostot painamalla Pura. Kohdekansion valintaikkuna 

avautuu.
• Voit purkaa kaikki arkistossa olevat tiedostot painamalla Pura kaikki.
• Voit katsoa arkistossa olevaa tiedostoa painamalla Näytä.

Voit myös lajitella arkiston sisällön. 
• Määritä lajitteluperuste valitsemalla Muokkaa > Lajitteluperuste. Vaihtoehdot 

ovat Nimi/ Päivämäärä/Koko.
• Määritä lajittelujärjestys valitsemalla Muokkaa > Lajittelujärjestys. Vaihtoehdot 

ovat Nouseva/Laskeva.

Powerpoint-esitykset
Vihje: Seuraava kalvo / 

Edellinen kalvo -komentojen 
pikanäppäimet ovat Shift-
Ctrl-N ja Shift-Ctrl-P.

Voit katsoa kalvoja painamalla Menu-näppäintä ja valitsemalla Kalvo > Seuraava 
kalvo / Edellinen kalvo. Muut Kalvo-valikon komennot toimivat aivan samalla tavalla 
kuin Kuva-valikon komennot.

Tiedostojen katselun valintojen määrittäminen
Paina Menu-näppäintä ja valitse Näytä > Valinnat. Esiin tulee kaksisivuinen 
valintaikkuna. Tee seuraavat määritykset:
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Oletusfontti: Voit valita oletusfontin painamalla Muuta. Fontti-valintaikkuna 

avautuu.
Näytä tuntemattomat tiedostot: Määrittää, miten katselusovellus käsittelee 

tuntemattomia tiedostotyyppejä. Vaihtoehdot ovat Tekstinä/
Heksadesimaalina/Ei näytetä.

Näytä ei-tuetut tiedostot: Määrittää, miten katselusovellus käsittelee ei-tuettuja 
tiedostotyyppejä. Vaihtoehdot ovat Kysy käyttäjältä/Avaa rekisteröidyssä 
sovelluksessa/Tuntemattomina.

Muut-sivu
Näytä ruudukko: Valitse laskentataulukon ruudukon oletusasetus. Vaihtoehdot 

ovat Kyllä/Ei.
Arkistojen lajitteluperuste: Valitse arkistotiedostojen oletuslajitteluperuste. 

Vaihtoehdot ovat Nimi/Päivämäärä/Tyyppi/Koko.
Lajittelujärjestys: Valitse oletuslajittelujärjestys. Vaihtoehdot ovat Nouseva/Laskeva.
Voit sulkea valintaikkunan painamalla Sulje.
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Kuva 5

Notes on yksinkertainen tekstinmuokkaustila, jossa voidaan kirjoittaa lyhyitä 
muistiinpanoja ja luoda muistiinpanolistoja. Muistiinpanoista voi luoda 
muistiinpanolistan. Listan voi lajitella usealla eri tavalla ja tallentaa muistikirjaksi. 
Notes-sovelluksessa on monia tekstinkäsittelyohjelmista löytyviä vakiokomentoja.

Notes on saatavissa vain englanniksi.

Muistiinpanojen ja muistikirjojen lisääminen ja 
poistaminen
Voit lisätä uuden muistiinpanon painamalla New note. 

Voit poistaa muistiinpanon painamalla Menu-näppäintä ja valitsemalla File > 
Delete note.

Voit lisätä uuden muistikirjan painamalla Menu-näppäintä ja valitsemalla File > 
New file. Eri aiheille voi lisätä omia muistikirjoja.
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Vihje: 

Muistiinpanonäkymässä voi 
kätevästi muokata suuria 
tekstimääriä. Jaetussa 
näkymässä voi selata 
muistikirjaa.

Voit katsoa muistiinpanon sisältöä tai sekä muistiinpanoa että muistiinpanolistaa. 
Voit valita näkymän painamalla Menu-näppäintä ja valitsemalla View > Split view/
Note view.

Voit siirtyä näkymästä toiseen jaetussa näkymässä painamalla Change Focus.

Jos haluat katsoa nykyistä näkymää koko näytöllä, paina Menu-näppäintä ja 
valitse View > Full screen. Voit palata normaaliin näkymään valitsemalla uudelleen 
Full screen.

Muistiinpanon tekstin muotoileminen
1 Valitse muokattava teksti.
2 Paina Menu-näppäintä ja valitse vaihtoehtoja Format-valikosta:

Valitse Font…, jos haluat muuttaa tekstissä käytetyn fontin tai lihavoida, 
kursivoida tai alleviivata tekstiä tai lisätä luettelomerkkejä. 

Muistiinpanon sanamäärän laskeminen
Vihje: Sanamäärän 

laskemistoiminto on 
hyödyllinen, jos haluat 
lähettää muistiinpanon 
tekstiviestinä, jonka 
enimmäismerkkimäärä on 
noin 160.

Paina Menu-näppäintä ja valitse Tools > Word count. 

Oikeinkirjoituksen tarkistaminen
Jos olet asentanut Spell checker -sovelluksen, voit tarkistaa muistiinpanon 
oikeinkirjoituksen seuraavasti:
1 Paina Menu-näppäintä ja valitse Tools > Spell check.
2 Jos haluat saada ehdotuksia tuntemattomalle sanalle, korosta Ehdotukset kohta 

ja valitse Muuta.
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Voit lajitella muistiinpanoja muistikirjassa seuraavasti:
1 Paina Menu-näppäintä, valitse ensin Tools > Sort by ja sitten lajitteluperuste. 

Vaihtoehdot ovat Creation Date/Last Modified Date/Title.
2 Voit valita lajittelujärjestyksen painamalla Menu-näppäintä, valitsemalla ensin 

Tools > Sorting Order ja sitten Ascending tai Descending.

Asetukset
Voit katsoa Notes-sovelluksen asetuksia painamalla Menu-näppäintä ja 
valitsemalla Tools > Preferences. Esiin tulee kaksisivuinen valintaikkuna. Tee 
seuraavat määritykset: 

View Preferences -sivu
Show title of entries on - Määritä, näkyykö listanäkymä jaetussa näkymässä 
vasemmalla vai oikealla.

Note width - Määritä muistiinpanonäkymän leveys jaetussa näkymässä. 
Valittavissa ovat arvot 10 - 80 %.

Display - Määritä näytön alareunassa olevalla tilarivillä näkyvän päivämäärän 
tyyppi. Vaihtoehdot ovat Last update date /Creation date.

Note Preferences -sivu
Always start on a new note - Voit valita, luoko Notes automaattisesti uuden 
muistiinpanon käyttäjälle. Vaihtoehdot ovat No / Yes.



©2001 Nokia Mobile Phones. All rights reserved. 

18
CD

-R
O

M
-l

ev
yn

 o
hj

el
m

at Include in list - Voit määrittää, miten paljon tekstiä näkyy muistiinpanolistalla 
jaetussa näkymässä. Vaihtoehdot ovat First line / All text. Jos valitset First line 
-vaihtoehdon, vain muistiinpanon ensimmäinen rivi näkyy. Jos valitset All text 
-vaihtoehdon, näkyviin tulee mahdollisimman paljon tekstiä.

Muistiinpanojen tulostaminen
Voit tulostaa muistiinpanon painamalla Menu-näppäintä ja valitsemalla File > 
Printing > Print…. 

Voit määrittää sivun asettelun painamalla Menu-näppäintä ja valitsemalla File > 
Printing > Page setup… 

Jos haluat katsoa sivua etukäteen näytöllä ennen tulostamista, paina Menu-
näppäintä ja valitse File > Printing > Print preview….

Muistiinpanojen etsiminen
Etsintäikkunan avulla voidaan nopeasti ja helposti etsiä tai korvata tekstiä koko 
muistikirjasta. 
1 Paina Menu-näppäintä ja valitse Edit > Find.
2 Kirjoita etsittävä teksti. Paina Korvaa ja kirjoita korvaava teksti.
3 Voit tarkentaa hakua painamalla Valinnat ja valitsemalla saman kirjainkoon 

haun tai kokonaisten sanojen tai vain sanan osien haun.
4 Paina Etsi. Notes etsii tekstiä nykyisestä muistiinpanosta ja sitten muistikirjan 

muista muistiinpanoista.
5 Voit etsiä seuraavan esiintymän painamalla Etsi seuraava.
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Vihje: NIM tarkoittaa 
Nokia Interleaved 
Multimedia 
-tiedostomuotoa.

Multimedia converter on PC-sovellus. Multimedia converterin avulla voidaan 
muuntaa tavallisia videotiedostomuotoja NIM-muotoon, jota Nokia 9210 
Communicator pystyy toistamaan. Myös tavallisia äänitiedostomuotoja voidaan 
muuntaa WAV-muotoon, ja WAV-muotoisia äänitiedostoja voidaan optimoida 
käytettäväksi Nokia 9210 Communicatorissa. Muunnettuja WAV-tiedostoja voi 
käyttää esimerkiksi soittoääninä.

Kuva 6

Multimedia converterin käytöstä on suuria etuja:
• Kun tiedosto muunnetaan, muunnetun ääni- tai videotiedoston koko on 

yleensä paljon pienempi kuin alkuperäisen tiedoston. Sen ansiosta tiedoston 
toistaminen kommunikaattorilla ei vaadi paljon suoritustehoa ja on 
sujuvampaa. Itse asiassa monia tiedostoja ei voi toistaa kommunikaattorilla 
ollenkaan ilman muuntamista.
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Huomaa: Multimedia converter tukee useimpia tiedostoja, joita voi toistaa 

Windowsin Mediasoittimella. Se, mitä tiedostoja järjestelmä tukee, 
määräytyy siihen asennetun Mediasoittimen version ja asennettujen 
ääni- ja kuvasignaalin pakkauksenhallintaohjelmien mukaan. 
Tavallisesti Multimedia converter pystyy tukemaan useimpia AVI-, 
WAV-, MPG- ja MP3-tiedostoja.

Pelkän äänitiedoston optimointi
1 Valitse valikosta File > Open. Valintaikkuna avautuu.
2 Etsi muunnettava äänitiedosto selaamalla ja napsauta OK. Tiedoston tiedot 

siirtyvät ikkunan vasemmalla puolella oleviin Original file -kenttiin. Kentissä 
näkyy tiedoston tyyppi ja koko sekä toistoaika.

3 Valitse jompikumpi Audio format -kentän vaihtoehdoista: 
Low compression: Jos halutaan paras äänen laatu.
Normal compression: Äänen laatu on hieman huonompi mutta tiedoston koko 
huomattavasti pienempi.

4 Napsauta Convert. Muunnetun tiedoston tiedot siirtyvät ikkunan oikealla 
puolella oleviin Converted file -kenttiin.

5 Tallenna uusi tiedosto valitsemalla valikosta File > Save as.
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Vihje: Frame rate 
ilmaisee sen, kuinka 
nopeasti yksittäiset kuvat, 
jotka peräkkäin 
muodostavat liikkeen 
vaikutelman, näkyvät 
filmissä tai videossa. 
Kuvataajuus ilmoitetaan 
kuvina sekunnissa (fps). 
Mitä vähemmän kuvia, sitä 
enemmän video nykii.

1 Valitse valikosta File > Open. Valintaikkuna avautuu.
2 Etsi muunnettava videotiedosto selaamalla ja napsauta OK. Tiedoston tiedot 

siirtyvät ikkunan vasemmalla puolella oleviin Original file -kenttiin. Kentissä 
näkyy tiedoston tyyppi ja koko sekä toistoaika.

3 Valitse jompikumpi Video quality -kentän vaihtoehdoista:
Smooth motion, small image size: Jos halutaan suurin mahdollinen kuvataajuus. 
Normal motion, normal image size: Kuvan koko on normaali, mutta liike ei ole 
aivan niin sulavaa.

4 Jos tiedostossa on sekä kuvaa että ääntä, valitse jompikumpi Audio format 
-kentän vaihtoehdoista:
Music, normal compression: Valitse tämä, jos lähdetiedostossa on musiikkia tai 
muuta korkealaatuista ääntä edellyttävää materiaalia.
Voice, high compression: Jos alkuperäisessä tiedostossa on vain puhetta tai pieni 
tiedostokoko on tärkeämpi kuin äänen laatu.

5 Napsauta Convert. Muunnetun tiedoston tiedot siirtyvät ikkunan oikealla 
puolella oleviin Converted file -kenttiin.
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alkuperäisen tiedoston 
ennen muuntamista ja 
muunnetun tiedoston 
muuntamisen jälkeen. 
Esikatselunäyttöjen 
alapuolella olevien 
säädinten avulla voit 
aloittaa ja lopettaa 
toistamisen tai pitää siinä 
tauon.

6 Tallenna uusi tiedosto valitsemalla valikosta File > Save as.
Huomaa: Tiedostojen toistamista ei voi aloittaa muuntamisen aikana.

Muunnetut tiedostot voi kopioida kommunikaattoriin PC Suite Nokia 9210 
Communicatorille -ohjelman avulla. Lisätietoja on myyntipakkauksesta löytyvästä 
PC Suite -oppaasta.

Pelit
Vihje: Nokian 

pelipalvelut saat käyttöösi 
liittymällä Club Nokiaan 
osoitteessa 
www.club.nokia.fi. 

Kommunikaattori ei ole vain tehokas työkalu, vaan se tarjoaa myös jännittävää 
vapaa-ajan viihdettä. Tästä osasta löydät upeita pelejä, joita voit pelata Nokia 
9210 Communicatorilla.

Asentaminen
Varmista, että Nokia 9210 Communicator on kytkettynä tietokoneeseen. Avaa 
CD-ROM-levy, valitse asennettava peli kansiosta Ohjelmia kommunikaattoria 
varten/Pelit ja paina Asenna.

Bounce
Bounce on peli, jossa ohjataan pientä palloa vaarallisessa maailmassa. Palloa 
pompotetaan ja vieritetään kullakin tasolla, ja samalla vältetään vaaroja ja 
kerätään renkaita, joita tarvitaan avaamaan pääsy seuraavalle tasolle. 
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painovoiman ja siten päästä käsiksi vaikeasti napattaviin renkaisiin. Ohjeet 
löytyvät pelistä. Bounce on vain englanninkielinen.

Kuva 7

Vaatimukset
Bounce edellyttää, että Nokia 9210 Communicatorissa on vähintään 1,5 
megatavua vapaata muistia ja 800 kilotavua vapaata levytilaa tai muistikortti.

Bounce-pelin aloittaminen
1 Valitse Bounce-kuvake Ekstrat-sovellusryhmästä nuolinäppäimellä ja paina 

Avaa.
2 Kun esiin tulee Bouncen animaatiologo, siirry päävalikkoon painamalla jotakin 

näppäintä.
3 Voit valita kohteita valikosta siirtymällä haluamasi kohteen kohdalle 

nuolinäppäimellä ja painamalla Enter-näppäintä.

Main Screen -valikko
Main Screen -valikossa on viisi vaihtoehtoa: Start Game, Online, Options, High Scores 
ja Quit.
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ja paina Enter-näppäintä tai alinta komentopainiketta.

Start Game -valikko
Start Game -valikossa on neljä vaihtoehtoa: New Game, Continue, Instructions ja 
Back. 

New Game aloittaa uuden pelin tasolta 1. 

Continue vie Continue-valikkoon.

Instructions käynnistää pelin ominaisuuksien automaattisen esittelyn. 

Back vie takaisin päävalikkoon.

Continue-valikko
Continue-valikossa on neljä paikkaa aiemmin tallennetuille peleille. Kussakin 
paikassa näkyy tallennetun pelin tasonumero ja jäljellä olevien elämien määrä. 
Valitsemalla paikan pelin voi aloittaa uudelleen tallennetun tason alusta, ja jäljellä 
on niin monta elämää kuin silloin, kun peli tallennettiin. Kun lataat tallennetun 
pelin, pistemäärä on nolla, joten ainoa tapa saada suurin mahdollinen pistemäärä 
on pelata pelin jokainen taso yhdellä kertaa! Back vie takaisin päävalikkoon.

Online-vaihtoehto
Valitsemalla Online-vaihtoehdon voit muodostaa yhteyden Nokia 9210 
Communicatorin pelien kotisivulle. Huomaa, että kommunikaattoriin on oltava 
määritetty Internet-yhteyden asetukset, jotta tämä toimisi. Kun suljet selaimen, 
pääset takaisin Bounce-päävalikkoon. Kotisivulla kannattaa käydä usein 
katsomassa tätä ja muita pelejä koskevia neuvoja, vihjeitä ja uutisia.
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voisi käyttää. Älä kytke puhelimeen virtaa silloin, kun 
matkapuhelimen käyttö on kielletty tai se voi aiheuttaa häiriöitä tai 
vaaratilanteen.

Options-valikko
Options-valikossa on kolme vaihtoehtoa: Change Keys, Change Sound ja Back. Change 
Keys -vaihtoehdolla voit määrittää ohjausnäppäimet uudelleen. Change Sound 
-vaihtoehdolla voit asettaa ääniefektien äänenvoimakkuuden. Back vie takaisin 
päävalikkoon.

Ennätyspisteet
High Scores -vaihtoehdolla saat esiin suurimmat pistemääräsi Bouncessa. Voit 
palata Main Screen -valikkoon valitsemalla Back.

Ohjausnäppäimet
Nuolinäppäimen <- ja >-nuolella siirretään palloa vasemmalle ja oikealle. Pallon 
saa pomppaamaan välinäppäimellä. Ohjausnäppäimiä voi muuttaa Options-valikon 
Change Keys -vaihtoehdolla.

Koon muuttaminen
Pallon koko voi muuttua, jos se koskettaa sopivia objekteja. Suuri pallo pomppaa 
korkeammalle ja liikkuu nopeammin kuin pieni pallo ja pystyy myös kellumaan 
vedessä. Pieni pallo mahtuu läpi pienistä aukoista.
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Pelissä on monia erilaisia elementtejä. Voit katsoa pelin ominaisuuksien esittelyä 
valitsemalla Instructions-vaihtoehdon Start Game -valikosta. Voit poistua 
esittelystä milloin tahansa painamalla jotakin näppäintä.

Pelin pysäyttäminen
Pelin voi pysäyttää painamalla Esc-näppäintä tai mitä tahansa komentopainiketta. 
Kun peli on pysäytetty, voit siirtyä Options-valikkoon ja määrittää näppäimet 
uudelleen tai muuttaa äänenvoimakkuutta. Voit myös lopettaa pelaamisen tai 
jatkaa sitä.

Tasojen välillä
Tason lopussa voit tallentaa pelin, muuttaa pelin valintoja, poistua pelistä tai 
jatkaa peliä. Jos tallennat pelin, esiin tulee neljän pelintallennuspaikan lista, jossa 
ovat jo tallennettujen pelien tasonumerot. Jos valitset Options, esiin tulee sama 
lista kuin päävalikon Options-valikossa. Jos valitset End game, nykyinen peli päättyy 
ja esiin tulee päävalikko. Valitsemalla Continue pääset seuraavalle tasolle.

Pelin päättyminen
Peli päättyy, kun joko pääset läpi kaikista tasoista tai menetät kaikki elämäsi. Jos 
pistemääräsi on tarpeeksi suuri pelin päättyessä, voit halutessasi lisätä nimesi 
pistetaulukkoon.
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Triplepop on nopeatempoinen peli, jossa eriväriset pallot lentävät sivuilta näytölle 
ja muodostavat kasan näytön keskelle. Pyörittämällä kasaa saat vapaasti lentävät 
pallot laskeutumaan haluamaasi paikkaan. Kun saat kolme samanväristä palloa 
vierekkäin, ne poksahtavat! Jos et ole tarpeeksi nopea, kasa kasvaa liian suureksi ja 
häviät. Triplepop on vain englanninkielinen.

Kuva 8

Vaatimukset
Triplepop edellyttää, että Nokia 9210 Communicatorissa on vähintään 1,5 
megatavua vapaata muistia ja 800 kilotavua vapaata levytilaa tai muistikortti.

Triplepop-pelin aloittaminen
1 Valitse Triplepop-kuvake Ekstrat-sovellusryhmästä nuolinäppäimellä ja paina 

Avaa. 
2 Kun esiin tulee Triplepopin animaatiologo, siirry päävalikkoon painamalla 

jotakin näppäintä.
3 Voit valita kohteita valikosta siirtymällä haluamasi kohteen kohdalle 

nuolinäppäimellä ja painamalla Enter-näppäintä.
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Main Screen -valikossa on viisi vaihtoehtoa: Start Game, Online, Options, High Scores 
ja Quit. Jos haluat lopettaa, valitse Quit-vaihtoehto painamalla nuolinäppäimen 
>-nuolta ja paina Enter-näppäintä tai alinta komentopainiketta.

Start Game -valikko
Start Game -valikossa on neljä vaihtoehtoa: New Game, Change Skill, Instructions ja 
Back. New Game aloittaa uuden pelin valittuna olevalla taitotasolla. Change Skill vie 
Skill Options -näyttöön, jossa voit muuttaa taitotason, ja valitsemalla Instructions 
saat esiin peliohjeet. Back vie takaisin Main Screen -valikkoon.

Taitotason muuttaminen
Skill Options -valikossa on kolme mahdollista taitotasoa (Easy, Medium ja Hard) sekä 
Back-vaihtoehto, jolla voi palata päävalikkoon. Valittuna oleva taitotaso näkyy 
korostettuna.

Online-vaihtoehto
Valitsemalla Online-vaihtoehdon voit muodostaa yhteyden Nokia 9210 
Communicatorin pelien kotisivulle. Huomaa, että kommunikaattoriin on oltava 
määritetty Internet-yhteyden asetukset, jotta tämä toimisi. Kun suljet selaimen, 
pääset takaisin Triplepop-päävalikkoon.

Huomaa: Kommunikaattorin puhelimen on oltava päällä, jotta tätä toimintoa 
voisi käyttää. Älä kytke puhelimeen virtaa silloin, kun 
matkapuhelimen käyttö on kielletty tai se voi aiheuttaa häiriöitä tai 
vaaratilanteen.
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Options-valikossa on kolme vaihtoehtoa: Change Sound, Change Keys ja Back. Change 
Sound -vaihtoehdolla voit asettaa ääniefektien äänenvoimakkuuden. Change Keys 
-vaihtoehdolla voit määrittää ohjausnäppäimet uudelleen, ja Back vie takaisin 
päävalikkoon.

Ennätyspisteet
High Scores -vaihtoehdolla saat esiin suurimmat pistemääräsi Triplepopissa. Voit 
palata Main Screen -valikkoon valitsemalla Back.

Pelin kulku
Pelissä ohjataan pallojen muodostamaa kasaa, jossa on musta kivi keskellä. Pelin 
aikana palloja ilmestyy vasemmalta ja oikealta, ja ne liikkuvat keskustaa kohti ja 
tarttuvat kasaan.

Kasaa voi kierrättää nuolinäppäimen <- ja >-nuolilla, jolloin pallot voi saada 
osumaan haluttuun kohtaan. Kasa kasvaa, kunnes se ylittää ympyränmuotoisen 
rajan, jolloin peli päättyy.

Palloja on neljänvärisiä: punaisia, vihreitä, keltaisia ja sinisiä. Vähintään kolmen 
samanvärisen pallon muodostamat ketjut poksahtavat ja katoavat, ja jokaisesta 
poksahtaneesta pallosta saa 5 pistettä. Varo myöhemmin liikkumattomia palloja. 
Liikkumattomien pallojen ketjut eivät poksahda itsestään, vaan silloin, kun 
toisenväriset pallot etenevät niiden kautta.

Kun aika kuluu, kasaan kuuluvat pallot alkavat vilkkua ja muuttuvat lopulta kiveksi. 
Kiviä voi tuhota vain laukaisemalla erityisiä bonuspalloja niitä kohti.
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vähintään neljä palloa kerralla. Mitä pitempi ketju, sitä suurempi bonus. Kun 
mittari täyttyy, kuvakkeisiin syttyvä valo osoittaa, mikä bonuspallo laukaistaan 
painettaessa <tulitus>-näppäintä. Bonuspalloja on neljä erilaista, ja kukin niistä 
vaikuttaa eri tavalla kasaan.

Vaikutukset ovat seuraavat:
• poksauttaa sen kohdan vieressä olevat pallot, jossa se osuu kasaan
• poksauttaa pallot osumakohdasta keskuskiveen
• poksauttaa pallojen kehän kasan ympäriltä osumakohdassa
• poksauttaa kaikki pallot sen kehän sisältä ja yläpuolelta, johon se osuu

Jos pistemääräsi on tarpeeksi suuri pelin päättyessä, voit halutessasi lisätä nimesi 
pistetaulukkoon.

Ohjausnäppäimet
Oletusohjausnäppäimet ovat seuraavat:
• Vasemmalle - nuolinäppäimen <-nuoli
• Oikealle - nuolinäppäimen >-nuoli
• Tulitus - välinäppäin

Pelin pysäyttäminen
Pelin voi pysäyttää painamalla Esc-näppäintä tai mitä tahansa komentopainiketta. 
Kun peli on pysäytetty, voit siirtyä Game Options -näyttöön ja määrittää 
näppäimet uudelleen tai muuttaa äänenvoimakkuutta. Voit myös lopettaa 
pelaamisen tai jatkaa sitä.
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Pasianssipelit kuuluvat ehkä maailman tunnetuimpiin ja suosituimpiin 
korttipeleihin. Nokia 9210 Communicatorin Card Deck tarjoaa mielenkiintoista 
viihdettä ja useita pasianssipelejä.

Kuva 9

Vaatimukset
Card Deck edellyttää, että Nokia 9210 Communicatorissa on noin 1,2 megatavua 
vapaata muistia ja 400 kilotavua vapaata levytilaa tai muistikortti.

Card Deckin käynnistäminen
1 Valitse Card Deck -kuvake Ekstrat-sovellusryhmästä nuolinäppäimellä ja paina 

Avaa. 
2 Kun esiin tulee Card Deck -aloitusnäyttö, paina Play ja valitse peli listalta. 

Lisätietoa pelien säännöistä saat painamalla Ctrl + H.

Ohjausnäppäimet
• Kohdistinta siirretään nuolinäppäimellä.
• Pakasta toiseen siirrytään painamalla nuolinäppäimen <- tai >-nuolta.
• Pakassa siirrytään painamalla ylä- ja alanuolia.
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• Uudet kortit jaetaan pöydälle painamalla Enter-näppäintä.

Online-vaihtoehto
Nokia 9210 Communicatorin pelien kotisivulta osoitteesta www.nokia.com/
games/92xx löydät tätä ja muita pelejä koskevia neuvoja ja vihjeitä.

Snake EX
Snake EX on Nokian klassisen matopelin parannettu versio Nokia 9210 
Communicatoria varten.

Kuva 10

Vaatimukset
Snake EX edellyttää, että Nokia 9210 Communicatorissa on noin 1,2 megatavua 
vapaata muistia ja 650 kilotavua vapaata levytilaa.

Snake EX -pelin aloittaminen
1 Valitse Snake EX -kuvake Ekstrat-sovellusryhmästä nuolinäppäimellä ja paina 

Avaa.
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valitse sitten ohjausnäppäimet, vaikeustaso ja monen pelaajan asetukset. 
3 Aloita uusi peli painamalla Play.

Pelin kulku
Ohjaa mato ruoan luo, jotta saisit sen kasvamaan pituutta. Matoa ei voi pysäyttää, 
eikä sitä saa kulkemaan takaperin. Vältä osumasta seiniin tai madon takapäähän. 
Ruoan lisäksi pelialueella on powerup-kohteita. Powerup-kohteet voivat joko 
helpottaa peliä tai tehdä siitä tilapäisesti vaikeamman. Ne näkyvät 
kysymysmerkkeinä näytöllä. Niiden vaikutus on salaisuus, kunnes mato syö ne.

Pelissä on kaksi tilaa. Klassisessa tilassa voidaan valita sokkelo, jossa pelataan, ja 
madon liikkumisnopeus. Extreme-tilassa edetään sokkelosta toiseen, kun on 
saavutettu tietty pistemäärä.

Voit myös haastaa ystäväsi pelaamaan. Kaksinpeliä voi pelata joko yhdellä 
laitteella tai kahdella laitteella infrapunayhteyden kautta.

Ohjausnäppäimet ja kieli
Matoa voi ohjata kolmella eri tavalla:
• Suoraan - käytä nuolinäppäintä
• Suunnan muuttaminen - käytä nuolinäppäimen <- ja >-nuolia. Mato kääntyy 

myötä- tai vastapäivään.
• Vinosti - käytä vinonuolia. Esimerkiksi vasen ylänuoli kääntää madon ylöspäin 

tai vasemmalle ja oikea alanuoli kääntää madon alaspäin tai oikealle.

Madolla on kieli. Sen avulla mato voi napata ruokaa etäältä. Kieltä ohjataan 
välinäppäimellä.
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Pelissä on viisi vaikeustasoa. Ensimmäisellä tasolla mato liikkuu hitaasti, ja sitä on 
helppo ohjata. Ylemmillä tasoilla mato liikkuu nopeammin, mutta ruoan 
syömisestä saa enemmän pisteitä.

Sokkelot
Klassisessa tilassa voidaan valita sokkelo pelin alussa. Sokkeloissa on erilaisia 
ruokia ja powerup-kohteita. Extreme-tilassa aloitetaan ensimmäisestä sokkelosta 
ja edetään vaikeampaa sokkeloon, kun on saavutettu tietty pistemäärä.

Powerup-kohteet
Pelissä on seitsemän erilaista powerup-kohdetta. Ne voivat tehdä pelistä 
helpomman tai vaikeamman tilapäisesti. Koskaan ei tiedä etukäteen, millainen 
powerup on kyseessä.
• Foodfest: pelialueelle ilmestyy lisäruokaa.
• Invincibility: Mato voi liikkua seinien ja takapäänsä läpi kuolematta.
• Reducer: lyhentää matoa. Vaikutus on pysyvä.
• Relax: hidastaa matoa.
• Reverse: muuttaa pelin ohjausnäppäimet päinvastaisiksi.
• Tongue: kaksinkertaistaa kielen pituuden.
• Turbo: tekee madon nopeammaksi.
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Fontit
Muut-alikansiossa on saatavilla kommunikaattoria varten lisäfontteja, joiden 
avulla voi vaihtaa merkkien ulkoasua.

Spell checker
Jos asennat Spell checker -sovelluksen Nokia 9210 Communicatoriin, voit tarkistaa 
sanojen ja tekstin oikeinkirjoituksen sovelluksissa (esimerkiksi Tekstinkäsittely-
sovelluksessa), joissa Oikeinkirjoituksen tarkistus… -komento on käytettävissä 
valikkolistalla. Yksityiskohtaisia tietoja oikeinkirjoituksen tarkistamisesta on 
Käyttöoppaan kohdassa Oikeinkirjoituksen tarkistaminen sivulla 30.

Huomaa: Vain englanninkielisen tekstin ja sanojen oikeinkirjoituksen voi 
tarkistaa.
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